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REVISION HISTORY 
This document will continue to evolve as existing sections change and new information is added. All updates appear in the 
following table: 

DATE WHAT'S CHANGED NOTES 

SEP 2020  Updated contents of entire document and added 
support for Microsoft Dynamics Unified UI 

AUG 2018  Added Oracle CPQ Cloud to the image on the cover 
page 

MAY 2018  Added the following sections: 

Insert Access Token in Header of URL Data 
Function 

User Integration for Microsoft Azure Directory 

FEB 2018  Initial Document Creation 

INTRODUCTION 
This document introduces the new Oracle CPQ Connector for Microsoft Dynamics 365. This solution allows users to create 
quotes in CPQ from within Dynamics, securely synchronizes data between the systems, and includes support for single-sign 
on via Azure Active Directory. 

This document is written for the administrator of your environment who has the access and permissions to customize your 
system. It guides the administrator through the installation of the Oracle CPQ Connector for Microsoft Dynamics 365, 
importing the Dynamics Migration Package and the process to setup the integration. It does not comprehensively describe 
every single feature that is part of the Dynamics-CPQ integration, please refer to the Oracle CPQ Administration Online Help 
for additional details. 

Before you begin, be sure to read the Prerequisites section. 

Note:  Most of the setup steps will be documented using the legacy customization interface, Microsoft is rolling out a 
newer experience for system customization. Administrators should use the interface they are most comfortable with, 
however some of the steps may be different than documented depending on the chosen interface. 

GIVE US FEEDBACK 

We welcome your comments and suggestions to improve the content. Please send us your feedback at 
cpqcloud_documentation_us_grp@oracle.com. 

mailto:cpqcloud_documentation_us_grp@oracle.com
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Prerequisites 
To successfully install and use the Oracle CPQ Connector for Microsoft Dynamics 365, there are a few prerequisites to be 
aware of which are listed in the table below. 

PREREQUISITE DESCRIPTION/ADDITIONAL INFORMATION 

Microsoft Dynamics 365 Version  A Microsoft Dynamics 365 environment; Version 9.0 or later. 

Dynamics 356 Sales Solution Dynamics 365 Sales, Enterprise Edition App installed. Refer to Set up 
Dynamics 365 Sales 

Oracle CPQ Version Update 18A or later. 

Oracle CPQ Update 18A is the minimum supported version. 
Occasionally, newly released features are not compatible with earlier 
versions of Oracle CPQ. Please reference the What's New documents 
for specific version compatibility details.  

Enable CRM OAuth in Oracle CPQ  You must verify Enable CRM OAuth setting is set to Yes in the Oracle 
CPQ Admin > General Site Options page. 

Use Price Books Enabled Oracle CPQ must be configured to use price books. This setting must 
be enabled by Oracle Cloud Operations. If price books are not enabled 
for your site, you must log a Service Request. Refer to My Oracle 
Support. 

Price Book Attribute Set Available Verify that you have the Price Book Attribute Set on your CPQ Main 
Document. If one does not exist, you must create it before beginning 
this process. 

My Oracle Support Account You need an active My Oracle Support account to complete these 
steps and receive assistance. Refer to My Oracle Support.  

 

Note:  This document assumes that the site has been provisioned with the latest Oracle CPQ Base Reference Application. 
If you have an older version of the Reference Application (Ref App) on the site, the integration is still expected to work 
but additional undocumented setup steps may be required. 

Check the Oracle CPQ and Reference Application Versions 
Before you begin you may want to check both the CPQ Version and the Reference Application version that was applied to your 
CPQ site. This section provides the steps to retrieve the application version, the Ref App version and the Catalog of Ref App 
elements file. This provides a more detailed view of the initial state of your site. 

This section provides procedures for the following: 

 Locate the Oracle CPQ Version Information 

 Locate the Reference Application Information 

https://docs.microsoft.com/en-us/dynamics365/sales-enterprise/set-up-dynamics-365-sales#install
https://docs.microsoft.com/en-us/dynamics365/sales-enterprise/set-up-dynamics-365-sales#install
https://support.oracle.com/
https://support.oracle.com/
https://support.oracle.com/
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LOCATE THE ORACLE CPQ VERSION INFORMATION 

To locate the CPQ version information, complete the following steps: 

1. Log in to Oracle CPQ. 

2. Navigate to the Admin Home page. 

 

3. Click CPQ Version Info. The Releases page displays. 

4. Note the Version.  

 

5. Click Back. 
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LOCATE THE REFERENCE APPLICATION INFORMATION 

When an Oracle CPQ site is provisioned, the Ref App is pre-loaded into the environment. In addition, files are added to the File 
Manager which indicate the version of the Ref App that is provisioned and describes the change history for the Ref App. These 
files are used to identify if your site requires updating to connect to the latest Managed package. 

To locate the current Reference Application Version Info and Read Me files, complete the following steps: 

1. Log in to Oracle CPQ. 

2. Navigate to the Admin Home page. 

3. Click File Manager under Utilities. The File Manager page displays. 

 

4. Click on the About folder. 

5. From the list of files within the folder, click on the README.txt file. The README file opens. 

 

6. Review the Oracle CPQ Reference Application version information to check if you have Base Ref App Version 4.0 or 
later. 

7. (Optional) Return to the About folder and select the RefAppVersionInfo.txt file. The RefAppVersionInfo file opens. 
Review the change log and Ref App version information.  

8. (Optional) Return to the About folder and select the CatalogOfRefAppElements.xlsx file. The 
CatalogOfRefAppElements file opens. Review the Microsoft Excel file which itemizes all of the elements contains in the 
latest Ref App. 
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My Oracle Support 
My Oracle Support enables you to search Oracle's knowledge base, manage Service Requests (SRs) when you need assistance, 
and take advantage of proactive capabilities for managing systems. During the installation and setup of the Oracle CPQ 
Connector for Microsoft Dynamics 365, you will be directed to open a Service Request (SR) on My Oracle Support. This section 
includes instructions on the following: 

 Register in My Oracle Support 

 Log an Oracle CPQ Connector for Microsoft Dynamics Service Request 

REGISTER IN MY ORACLE SUPPORT 

In order to log an Oracle Service Request (SR), you must have a Support Account with a registered Support Identifier (SI). An SI 
identifies the products that your company has purchased and the level of support that you are entitled to. The SI is included in 
the welcome letter sent from Oracle to the technical contact listed in your company’s contract.  

My Oracle Support (MOS) customer user accounts are managed by individuals within your organization in the role of 
Customer User Administrator (CUA). Most organizations have more than one CUA. The CUA approves or denies access to My 
Oracle Support by managing access to your company's SIs. 

If you are the first user to register, you are prompted to accept the CUA role. You must accept the CUA role for your 
organization to proceed. 

To access My Oracle Support, you must have an Oracle Single Sign On (SSO) account. This account is created when you 
complete the registration process on oracle.com. For additional SSO account information, refer to Requesting an Oracle Single 
Sign On Account. 

Once you have your SSO account established, go to My Oracle Support to complete the MOS registration and initial sign in 
process to obtain your Support Account. Detailed instructions are provided in the following article, Registration and Sign In. 

LOG AN ORACLE CPQ CONNECTOR FOR MICROSOFT DYNAMICS 365 SERVICE REQUEST 

Administrators will need to open Service Requests (SR) during the installation and setup of the Oracle CPQ/Dynamics 
integration. When opening an SR, it is important to provide all the relevant information required to ensure the Oracle support 
team can address the ticket in a timely fashion. 

Note:  You must have a Support Account with an approved Support Identifier (SI) to log a Service Request (SR). Refer to 
Registration and Sign In. 

To generate a CPQ Connector for Dynamics SR, complete the following steps: 

1. Navigate to the My Oracle Support (MOS) website. 

2. Sign in using your MOS Support Account credentials. 

3. Locate the Service Request tab and click Create SR. 

https://support.oracle.com/
https://www.oracle.com/index.html
https://docs.oracle.com/cd/E25290_01/doc.60/e25224/registration.htm#CACEJECG
https://docs.oracle.com/cd/E25290_01/doc.60/e25224/registration.htm#CACEJECG
https://support.oracle.com/
https://docs.oracle.com/cd/E25290_01/doc.60/e25224/registration.htm#CACEJECG
https://docs.oracle.com/cd/E25290_01/doc.60/e25224/registration.htm#CACEJECG
https://support.oracle.com/


 

 

Oracle CPQ Connector for Microsoft Dynamics 365 Installation and Setup Guide 8 

 

4. Enter a Problem Summary and Problem Description.  

FIELD DESCRIPTION 

Problem Summary A short description of the problem. 

Problem Description A detailed description of the problem, including the following 
information: 

 Solution name (for example, Oracle CPQ Connector for Microsoft 
Dynamics 365) 

 Solution version 

 Oracle CPQ version 

 Issue type (for example, Setup, Upgrade, Migration, or 
Troubleshooting) 

 If Setup, provide the last step completed in the guide 

 If Upgrade or Migration, provide the previous version of the 
managed package 

 If Troubleshooting, provide the steps to reproduce the error 

5. Select the Cloud tab within the Where’s the Problem section. 

6. Select Oracle BigMachines CPQ Service for the Service Type. 

7. Select Integration and General Integration from drop down for the Problem Type. 

8. Enter your Support Identifier. 

9. Enter the Severity as 3-Minor Loss of Service. 

10. Click Next.  

11. Follow the remaining steps as prompted. 

Note:  Refer to log an SR online help articles for further assistance. 

https://support.oracle.com/epmos/faces/DocumentDisplay?id=1484944.1
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INSTALLATION 
To begin configuring the Oracle CPQ Connector for Microsoft Dynamics 365 there are two (2) packages to install. 

1. The Oracle CPQ Connector Solution must be imported into Microsoft Dynamics.  

2. The Dynamics Integration Migration Package must be imported into Oracle CPQ.  

Each of these can be downloaded from My Oracle Support at: Oracle CPQ - Dynamics 365 Implementation Guides (Doc ID 
2364513.1).  

Notes:    

 Always install and test in a Sandbox environment before making any changes in production.  

 If you use multiple Microsoft logins, you should log out of any active sessions before beginning the installation. 

Import the Oracle CPQ Connector Solution into Dynamics 
To import the Oracle CPQ Connector for Microsoft Dynamics 365 into your Dynamics 365 environment complete the following 
steps: 

1. Login to the target Dynamics 365 site as an administrator. 

2. Navigate to Settings > Solutions.  

3. Import the Solution. For detailed instructions on these procedures, refer to the Microsoft Dynamics documentation 
article Import, update, and upgrade a solution. 

Import the Microsoft Dynamics Integration Package into Oracle CPQ 
To use the Migration Center to import the Microsoft Dynamics Integration package complete the following steps: 

1. Download the Microsoft Dynamics 365 migration package to your computer. 

2. Open the Admin Home page.   

3. Under Utilities, select Migration. The Migration Center opens. 

4. From the Offline Mode drop-down menu, select Import Package. 

 

5. From the Upload Package dialog, click Browse. 

 

6. Select the downloaded package from your computer.  

7. Click Open. 

https://support.oracle.com/
https://support.oracle.com/epmos/faces/DocumentDisplay?id=2364513.1
https://support.oracle.com/epmos/faces/DocumentDisplay?id=2364513.1
https://docs.microsoft.com/en-us/dynamics365/customer-engagement/customize/import-update-upgrade-solution
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8. From the Upload Package dialog, select a target process for cross process migration from the drop-down list. 

Note:  If you choose Default Migration for the target cross process migration, you will have some of the Commerce 
process migration elements but not the full Commerce process. Therefore, we recommend you select a target process for 
cross process migration. 

 

9. Click Upload. 

10. Click Migrate. The Migration dialog opens. 

11. (Optional) Enter a Migration Description. 

 

12. Click Migrate. 

13. Monitor the progress of the migration in the Status area at the bottom of the page. 

14. When the migration completes, click Logs at the bottom of the page. 
The Migration Logs window opens and indicates the success or failure of the migration. 
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AUTHENTICATION 
Now that you have installed the Oracle CPQ Connector for Microsoft Dynamics, there are additional setup procedures required 
to enable your Dynamics environment and Oracle CPQ site to communicate securely.  

Oracle CPQ supports the use of Azure Active Directory to provide secure authentication and single sign-on for Dynamics users 
with a valid CPQ license allowing them to access their CPQ content without leaving Dynamics. To successfully establish a 
connection, you need to setup Azure Active Directory. 

Setup Azure Active Directory 
This section provides instructions for configuring Azure Active Directory to authenticate with Oracle CPQ. To complete this, 
you will perform the following steps which are outlined in their own sections called: 

1. Create an App Registration 

2. Define API Permissions 

3. Create a Client Secret 

4. Locate the Client ID and Tenant ID 

5. Locate the Identity Provider URI 

6. Locate the Resource URI and App ID 

7. Provide Dynamics and Azure Active Directory Details to My Oracle Support 

CREATE AN APP REGISTRATION 

To register your Oracle CPQ site in the Azure Active Directory so that it can authenticate and modify Dynamics data, complete 
the following steps: 

1. Log in to Microsoft Azure at https://portal.azure.com.  

 

https://portal.azure.com/
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2. Navigate to Azure Active Directory > App registrations. 

 

Microsoft Azure Portal 

3. Click New registration.  

 

4. The Register an application page opens. 
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5. Enter the following values to create the App Registration. 

SETTING VALUE 

Name Descriptive name for the app 

Supported Account Types Choose appropriate access level.  

Default: Accounts on this organizational directory only – Single tenant.  

Redirect URI (Web) https://<cpq_site_domain>/admin/oauth2/dynamics365/oauth_callback.jsp 

6. Click Save. 

DEFINE API PERMISSIONS 

To define the API permissions for this App Registration, complete the following steps: 

1. Open the App Registration defined in the previous section.  

 

2. Navigate to API Permissions.  
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3. Click Add a permission. 

 

4. Select Dynamics CRM.  

 

5. Select Delegated Permissions, check user_impersonation.  

6. Click Add permission.  

7. Optionally, you can grant admin consent for your entire organization.  
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CREATE A CLIENT SECRET 

To create a client secret for this App Registration, complete the following steps.  

1. Open the App Registration defined in the earlier section.  

 

2. Navigate to Certificates & secrets.  

 

3. Click New client secret. 

   

4. Provide a descriptive name and choose the desired expiration timeframe. Oracle recommends selecting Never so that 
this does not need to be updated regularly. Click Add.  
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5. The new client secret is displayed.  

 

6. Record the value displayed. Once you leave this page you will no longer be able to view this secret, so it is important 
that you capture this value now.  

LOCATE THE CLIENT ID AND TENANT ID 

You must look up the Client ID and the Tenant ID for the App Registration that you previously created.  

1. Open the App Registration defined in the earlier section.  

2. View the Overview for the App Registration.  

 

3. Record the Application (client) ID and Directory (tenant) ID.  

Note:  The tenant ID shown above and the tenant name displayed under Custom domain names are interchangeable. 
Microsoft accepts both the Azure Portal's domain name and the ID as acceptable tenants. The values both point to the 
same location.  
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LOCATE THE IDENTITY PROVIDER URI 

You must look up the Identity Provider URI for the App Registration that you previously created.  

1. Open the App Registration defined in the earlier section.  

2. Navigate to the Endpoints page.  

 

3. The Endpoints page displays.  

 

4. Copy the OAuth 2.0 authorization endpoint (v1) value, it will be of the format: 

https://login.microsoftonline.com/38ef3fd8-dad2-4d94-b186-f508effa50af/oauth2/authorize 

5. Extract the Identity Provider URI, which will be the domain that is highlighted in yellow. 
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LOCATE THE RESOURCE URI AND APP ID 

You must look up the Resource URI and the App ID for your Dynamics 365 for Sales app. The Resource URI is the environment 
to which the app registration has data access, which is either the Dynamics 365 for Sales production or sandbox environment. 
The App ID is a unique identifier for the Model-driven Sales Hub app.  

Complete the following steps: 

1. Log into Microsoft Dynamics 365 Home at https://home.dynamics.com/  

 

2. Locate the Sales Hub app for the Dynamics instance that you are trying to connect, this may be a production or a 
sandbox environment. Click on the app. The Sales Hub home screen is displayed.  

3. Copy the URL from the browser window on the home screen, it will be of the format:  

https://mysite.crm.dynamics.com/main.aspx?appid=b3700bc4-45f7-e811-a953-
000d3a4e8995&pagetype=dashboard&id=2701de60-8f2a-48a4-8262-
4a35ca7441fa&type=system&_canOverride=true 

4. Extract the Resource URI, which will be the domain that is highlighted in yellow, and the AppID which will be a 
querystring parameter with the name appid, which is highlighted in green. Record these values.  

PROVIDE DYNAMICS AND AZURE ACTIVE DIRECTORY DETAILS TO MY ORACLE SUPPORT 

Once you have gathered the Client Secret, Client ID and Tenant ID, Identity Provider URI, Resource URI and App ID, you can 
finalize the integration process. My Oracle Support must fulfill the support portal ticket in order for the Oracle CPQ/Dynamics 
integration can be tested. 

Note:  You must have a Support Account with an approved Support Identifier (SI) to log a Service Request (SR). 

To complete the integration, complete the following steps: 

1. Generate an SR from the My Oracle Support (MOS) website. Refer to Log an Oracle CPQ Connector for Microsoft 
Dynamics 365 Service Request and specify the following field designations. 

2. Select Site Maintenance > Site Setting Changes for the Problem Type. 

3. Enter the Consumer Key into the Microsoft Dynamics Client Key field. 

4. Enter the Consumer Secret into the Microsoft Dynamics Consumer Secret field. 

https://home.dynamics.com/
https://support.oracle.com/epmos/faces/MosIndex.jspx?_afrLoop=569925007061100&_afrWindowMode=0&_adf.ctrl-state=ja40gj32g_4
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Integration User Pairing 
Once the Service Request in the previous section has been fulfilled, connect the Integration User (typically a SuperUser or 
dedicated integration user in CPQ) to their corresponding Dynamics user account (typically a system administrator or a 
dedicated integration user). 

If you have additional user accounts you’d like to pair manually, each user will individually follow the steps in the next section 
to pair their logins by generating a security token. You typically perform this step for your Integration User account first. 

Note:  Do not proceed with this process until Oracle CPQ Support has completed the Service Request to establish the 
security and connected app. Refer to Provide Dynamics and Azure Active Directory Details to My Oracle Support. 

PAIR INTEGRATION USER AND GENERATE ACCESS TOKEN 

The first step for integrating users is to pair the user accounts across systems. This is done by entering the Dynamics 
username that corresponds to the CPQ user on the User Integration page. If you do not currently have a user account in both 
systems, create a user account in each before continuing or contact your system administrator. 

User accounts must be paired before a user can SSO from Dynamics into Oracle CPQ. When a user punches into CPQ from 
Dynamics the first time an Access Token is automatically generated, however during the initial setup the Integration User will 
need to manually generate their access token to push data from CPQ to Dynamics using their APIs.   

Once a user has generated this token, they will continue to be able to sign on from Dynamics and sync data back to Dynamics 
from CPQ even after their Dynamics or CPQ user password changes. In this section, we describe how to manually generate the 
token. 

Note:  Before you begin, log out of all Dynamics instances so that you do not accidently pair to the wrong user account or 
instance.  

To pair a user and generate a token, complete the following steps: 

1. Log into Oracle CPQ with your Integration Username and Password. 

 

Oracle CPQ Login 

2. Click the My Profile icon in the Navigation bar at the top of the page. 

 

My Profile Icon 

Note:  The My Profile icon and location may vary based on your CPQ site configuration.  
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3. Click User Integration. 

 

My Profile – User Integration 

4. Enter your Dynamics username in the Login field. 

5. Click Generate Token. 

 

User Integration – Generate Token 

6. Log in to Dynamics with the sign in and password credentials for the user account you want to integrate. 
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The User Integration page displays showing the Revoke Token button that indicates that the token has been 
generated. 

 

 

Note:  You will need to repeat steps 1-4 for any additional users who wish to access Oracle CPQ from within Dynamics. 
The remaining steps to generate a token are optional as the token will be automatically generated for that user when 
they first punch into CPQ. If you try to access Oracle CPQ from Dynamics with a user that has not been paired, they will 
see errors when trying to open quotes. Review User Pairing for more detail.  



 

 

Oracle CPQ Connector for Microsoft Dynamics 365 Installation and Setup Guide 22 

 

PERMISSIONS AND PAGE LAYOUTS 
You must assign the new admin roles to your own profile. Only then can you access and configure the components of the 
managed solution. Once you have access to the components you must expose them in the UI by adding them to navigation 
menu and forms.  

Assign the Oracle CPQ Admin Role  
You must assign the CPQ Admin role to admin users, including your own user, in order to access and configure the Oracle 
CPQ Connector for Microsoft Dynamics 365. 

Note:  The below procedure assumes users have already been created in Office 365. If you have not previous created 
users, you must do so before completing these steps.  

To assign the CPQ Admin role, complete the following steps: 

1. Log into Dynamics 365 as an administrator. 

2. From the Navigation bar, go to Settings > Security.  

 

3. From the Security page, select Users. 

4. Select the user whose roles you want to adjust. The User page opens. 
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5. Select Manage Roles. The Manage User Roles dialog opens. 

 

6. Assign the CPQ Admin Role to the target users including your own admin user.  

This role grant access rights to the objects listed in the following table. 

OBJECT PERMISSION ENABLED 

Opportunity Create, Read, Update, Delete 

CPQ Site Settings Create, Read, Update, Delete 

These permissions additionally grant access to a number of Customization features which are required for the proper function 
of the managed package.  

Assign the Oracle CPQ Sales Role  
You must assign the CPQ Sales role to sales users, as well as your own user, in order to create quotes and test the end to end 
integration. Additionally, when you’re ready to roll Oracle CPQ out to the entire sales organization you will need to repeat this 
step for every user who will be a Oracle CPQ user.  

Note:  The below procedure assumes users have already been created in Office 365. If you have not previous created users, 
you must do so before completing these steps.  

To assign the Oracle CPQ Admin role, complete the following steps: 

1. Log into Dynamics 365 as an administrator. 

2. From the Navigation bar, go to Settings > Security.  
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3. From the Security page, select Users. 

4. Select the user whose roles you want to adjust. The User page opens. 

5. Select Manage Roles. The Manage User Roles dialog opens. 

 

6. Assign the CPQ Sales Role to the target users including your own admin user.  

This role grant access rights to the objects listed in the following table. 

OBJECT PERMISSION ENABLED 

Opportunity Create, Read, Update, Delete 

Oracle Quotes Create, Read, Update, Delete, Append, Append To, Assign, Share 

CPQ Site 
Settings 

Read, Append, Append To 

These permissions additionally grant access to a number of Customization features which are required for the proper function 
of the managed package.  
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Setup Page Layouts 
Now that you have access to the new entities, you must expose these entities in the Dynamics User Interface.  

EXPOSE ORACLE CPQ SITE SETTINGS  

A CPQ Site Settings entity is provided for administrators to simplify the setup and integration of their company’s instance of 
Oracle CPQ. Administrators must manually expose the CPQ Site Settings entity in Dynamics 365. 

Complete the following steps: 

1. Open Dynamics 365. 

2. From the Navigation bar, go to Settings > Solutions. 

 

3. From the All Solutions page, select Oracle CPQ Connector for Dynamics 365. 

4. From the list of components, select the CPQ Site Settings entity. 

5. Under Areas that display this entity, select Settings. 

 

6. Click Save. 

7. Click Publish. 

Note:  Reminder, the logged in user must have been granted security access to the CPQ Site Settings entity in order to 
access it.  
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ADD ORACLE QUOTE ENTITY TO OPPORTUNITY LAYOUT 

An Oracle Quote entity is provided for initiating new quotes and storing synced quote data. You must add the Oracle Quote 
entity to the Opportunity layout so that you can view the create quote action and to see a list of quotes that are linked to the 
open opportunity.   

Complete the following steps: 

1. Open Dynamics 365. 

2. From the Navigation bar, go to Settings > Customizations. The Customization page opens. 

 

3. Select Customize the System. The Information page opens. 

4. Expand the Opportunity entity and select Forms. 

 

5. Open the Main form. 
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6. From the Insert menu, select Sub-Grid. The Set Properties dialog opens. 

 

7. In the Name field, specify a unique name for the sub-grid. 

8. From the Records drop-down, select Only Related Records. 

9. From the Entity drop-down, select Oracle Quotes (Opportunity ID). 

10. From the Default View drop-down, select Active Oracle Quotes. 

11. Click OK. 

12. From the Home tab of the form, select Publish. The Oracle Quote displays within the active Opportunity. 

 

Opportunity - Legacy Web Client  
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Opportunity – Unified Interface  

13. Optionally, you can repeat this process to add the Oracle Quote list to the Account form. Before doing so you will need 
to ensure that there’s a relationship created from the Account to the Oracle Quote.   
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INTEGRATION SETTINGS 
In order to sync data between Oracle CPQ and Dynamics, you must set up the relationships between the objects, actions and 
fields that are used in each system. Some of these settings are managed in Oracle CPQ and others in Dynamics. The following 
sections walk you through the set up within each system. 

Note:  The following sections assume that the CPQ site has been provisioned with the latest Oracle CPQ Base Reference 
Application. If you do not have the latest Reference Application (Ref App) on the site, additional undocumented setup 
steps may be required.  

Oracle CPQ Site Settings 
The CPQ Site Settings page, that is part of the managed solution, is a form filled out by the administrator. Data specific to your 
environments is entered, such as the Site Domain and Process Name. This initial setup allows you to quickly connect your 
Oracle CPQ and Dynamics environments.  

Note:  Most of the setup steps will be documented using the legacy customization interface, Microsoft is rolling out a 
newer experience for system customization. Administrators should use the interface they are most comfortable with, 
however some of the steps may be different than documented depending on the chosen interface.  

RETRIEVE ORACLE CPQ INTERGATION PARAMETERS 

Before entering the Oracle CPQ Site Settings, you must retrieve the Version ID from CPQ for the Commerce Process that you 
want to pair to Dynamics. 

To retrieve your integration parameters, complete the following steps: 

1. Log in to Oracle CPQ as an admin. 

2. Navigate to the Admin home page > Commerce and Documents > Process Definition. The Processes page 
displays. 

3. Select the desired process and select Integrations from the Navigation drop-down. 

4. Click List. The Integrations page displays. 

5. Click View Parameters. The parameters display. 

6. Collect the information below. This information is needed to create site settings. 

 

Sample Integration Parameters Output 
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CREATE ORACLE CPQ SITE SETTINGS 

Next you must input the integration parameters into the Oracle CPQ Site Settings page. When creating Oracle CPQ Site 
Settings, administrators are supplying information about the CPQ site, process and actions that is being integrated. These 
properties will be used when punching into when creating and editing quotes.    

Complete the following steps: 

1. Open Dynamics 365. 

2. From the Navigation bar, go to Settings > CPQ Site Settings. 

 

3. From the top left of the Active CPQ Site Settings page, click New. The New CPQ Site Settings page opens. 

 

4. Populate the following settings: 

 Name: A descriptive name for the CPQ site to which the settings apply. 

 Site Domain: The root URL of the CPQ site to which the administrator is connecting. For example: 
https://[yoursite].oracle.com 

 Process Name: The variable name of the Commerce process that launches when creating a quote. 

 Commerce Process ID: The unique ID of the Commerce process that launches when creating a quote. 

 Document ID: The unique ID for the Main Document in the Commerce process. 

 Open Action ID: The unique ID of the Open action used when editing a quote. 

 Use Unified UI: A Boolean which tells the application which Dynamics user interface you are integrating with. Set 
this to TRUE if you are using the newer Unified Interface, set it to FALSE if you are using the legacy web client.  
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5. Click Save. 

Notes:   

 When entering the Site Domain do not enter any trailing slashes or include a path, doing so will cause errors. 

 If you are upgrading from an earlier version of the Oracle CPQ Connector for Dynamics (v0.3 or prior) you may see 
blank values for the Commerce Process, Document ID and Open Action ID after upgrade. This is because new 
fields with a different data type were added in v1.0. The integration will continue to work as the old values have 
been retained, but we recommend re-populating these values after upgrade.   

CREATE BUSINESS RULE TO SET THE CPQ SITE ON NEW ORACLE QUOTES 

Each time a new quote is created, it must be assigned the Oracle CPQ Site Settings that were created in the previous step. This 
is important because the managed solution will use this value to look up the integration details when punching into CPQ.  This 
is done by creating a Business Rule which automatically sets a default value for the CPQ Site field.  

Complete the following steps: 

1. Open Dynamics 365. 

2. From the Navigation bar, go to Settings > Solutions. 

3. From the All Solutions page, select Oracle CPQ Connector for Dynamics 365. 

4. From the list of components, select the Oracle Quote entity. 

 

5. Under Business Rules, select New. 
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6. Populate the condition’s properties, as follows: 

 In the Display Name field, enter a display name for the business rule. 

 In the Entity field, enter Oracle Quote. 

 From the Source drop-down, select Entity. 

 From the Field drop-down, select CPQ Site. 

 From the Operator drop-down, select Does not contain data. 

 The Condition Expression text box auto-populates based on your entries.  
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7. Click Apply. 

8. Open the Components tab. 

9. Drag the Set Field Value component to the condition's window. 

 

10. Populate the properties for the action, as follows: 

 Display Name: Set Default CPQ site 

 Entity: Oracle Quote 

 Field: CPQ Site 

 Type: Value 

 Value: Search for a pre-existing Oracle CPQ site 
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11. Click Apply. 

12. Click Save. 

13. Click Activate. 
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EDIT BUSINESS RULE TO SET THE CPQ SITE ON NEW ORACLE QUOTES 

If at any point you need to modify this business rule to change the default site settings you can do so by deactivating the rules 
and editing it.  

Optionally, you can edit the business rule by completing the following steps: 

1. Open Dynamics 365. 

2. From the Navigation bar, go to Settings > Solutions. 

3. From the All Solutions page, select Oracle CPQ Connector for Dynamics 365. 

4. From the list of components, select the Oracle Quote entity. 

5. Navigate to Business Rules and open the target process. 

6. Deactivate the process to make it editable. 

7. Click Set Default Value. 

8. Click Value to search for a different CPQ Site Settings record. 

9. Click Apply. 

10. Click Save. 

11. Click Activate. 

Configure Data Synchronization  
Administrators must configure Oracle CPQ to connect to their Dynamics 365 instance and to push and pull data from the 
correct entities and fields. The Microsoft Dynamics Integration migration package that you previously imported into your CPQ 
site contains a number of attributes, actions, functions and tables which support this process. When properly configured, 
these components transfer data between the systems when users create or update quotes in Dynamics 365 or mark a quote 
as primary and synchronize its data to the Opportunity. 

Note:  For information about the components included in the Microsoft Dynamics Integration migration package, refer to 
Appendix A: Migration Package Components.  

CONFIGURE CALLOUT SETTINGS AND FIELD MAPPINGS 

The first step in setting up the data synchronization between the two systems is to populate the Callout Settings, Account 
Mappings, Import Mappings and Export Mappings tables that are part of the migration package. These tables are an analog to 
the CPQ Site Settings page in Dynamics and allow you to record the entity names and attributes that you will be integrating 
with.  

Complete the following steps to view or modify the data tables: 

1. Open the Admin Home page. 

2. Under Developer Tools, click Data Tables. 
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3. Expand the Integration folder. 

 

4. Double click on the CalloutSettings table.  

 

5. The table should have two rows, one for defining the quote integration and one of defining the account integration.  
Populate the table cells according to the following table.  

COLUMN NAME DESCRIPTION 

process Specifies the varname of the process that is being integrated.  

 For the quotes integration this value should be the varname of your commerce 
process. In the base RefApp it will typically be oraclecpqo 

 For the accounts integration this value should be account 

document Specifies the varname of the quote header in CPQ.  

 For the quotes integration this value should be the varname of your main document. 
In the base RefApp it will typically be transaction 

 For the accounts integration this value should be blank 
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COLUMN NAME DESCRIPTION 

subdocument Specifies the varname of the quote line in CPQ.  

 For the quotes integration this value should be the varname of your sub-document. 
In the base RefApp it will typically be transactionLine 

 For the accounts integration this value should be blank 

interface Specifies the commerce process’ REST endpoint in CPQ.  

 For the quotes integration this value can be found under Interface Catalogs. In the 
base RefApp it will typically be commerceDocumentsOraclecpqoTransaction 

 For the accounts integration this value should be blank 

dynamicsURL Specifies the REST endpoint for your Dynamics instance.  

 For both the quotes and accounts integrations this value will typically be in the 
format: https://<resource URI>/api/data/v8.2 

parentEntity Specifies the entity schema name of the Oracle Quote’s parent in Dynamics.  

 For the quotes integration this value should be opportunities 

 For the accounts integration this value should be accounts 

entity Specifies the entity schema name of the Oracle Quote in Dynamics.  

 For the quotes integration this value should be ocpq_oracle_quotes 

 For the accounts integration this value should be blank 

childEntity Specifies the entity schema name of the Oracle Quote’s children in Dynamics.  

 For the quotes integration this value should be opportunityproducts 

 For the accounts integration this value should be contacts 

Note:  We recommend using v8.2 of the API when setting the DynamicsURL as this is what the provided solution has 
been certified with. Changing to a newer version could result in a change in behavior and may require a refactoring of the 
provided BML integrations.  

6. Click Save and Deploy.  
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7. Next, you will update the Export Mappings to map which fields from Oracle CPQ are to be pushed to which fields in 
Dynamics when saving a quote and synchronizing opportunity products. Double click on the ExportMappings table.  

 

8. This table will contain several rows by default, you need to update them to align the values to your site’s 
implementation and to add additional rows for any additional fields you want to push to Dynamics. Populate the table 
cells according to the following table.   

COLUMN NAME DESCRIPTION 

entity The name of the Dynamics entity containing the field to be updated. By 
default, there are three entities which will be mapped.  

 ocpq_oracle_quotes – this is the Oracle Quote entity that is 
provided with the solution. Each main document field that will be 
updated on the quote in Dynamics will have a row that contains this 
value in the entity column.  

 opportunities – this is the Opportunity entity. Each main 
document field that will be updated on the parent opportunity will 
have a row that contains this value in the entity column.  

 opportunityproducts – this is the Opportunity Product entity. 
Each sub- document field that will be updated on the opportunity 
products will have a row that contains this value in the entity 
column. 

field The schema name of the field on the specified Dynamics entity. Several 
of the default fields will be included, but you must validate these values 
with your environment. Additionally, you must ensure that all required 
fields are included.  

fieldIsReference Indicates if the mapped field is a Lookup type field on the specified entity. 
If it is a Lookup, it should be set to TRUE. Otherwise it will be set to 
FALSE.  
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COLUMN NAME DESCRIPTION 

document The name of the CPQ document which contains the attribute which is 
being exported to Dynamics. There are two documents which will be 
mapped.  

 Main document – the main document varname in your CPQ site. In 
the base RefApp it will typically be transaction. Each attribute 
that will be exported to the opportunity or quote in Dynamics will 
have a row that contains this value in the document column.  

 Sub-document – the sub-document varname in your CPQ site. In 
the base RefApp it will typically be transactionLine. Each 
attribute that will be exported to the opportunity product in 
Dynamics will have a row that contains this value in the document 
column.  

attribute The varname of the attribute on the specified document in CPQ. Several 
of the default attributes will be included, but you must validate these 
values with your site. 

process The varname of the process that contains the attributes being mapped. In 
the base RefApp it will typically be oraclecpqo. 

isExternalID Indicates if the mapped field is a Primary Key on the specified entity. If it 
is a Primary Key, it should be set to TRUE. Otherwise it will be blank. All 
entities must have exactly one row flagged as TRUE. 

dataType Specifies the data type of the entity field being updated in Dynamics. 
Supported values are: 

 (blank) – Text field and Multiple Lines of Text 

 float - Floating Point Number and Decimal Number 

 currency - Currency 

 date – Date and Time 

 datetime – Date and Time 

 integer - Whole Number 

 menusingle - Option Set 

 menumulti - Multi-Select Option Set 

 boolean - Two Options 

Note: When integrating multi-select menus the variable name of the 
entry in Oracle CPQ needs to match the entry in Dynamics.  

9. Save and Deploy.  

10. Next, you will update the Import Mappings to map which fields from Dynamics are to be fetched and saved to the 
quote fields in CPQ as part of the Import Opportunity and Import Quote integrations. Double click on the 
ImportMappings table. 
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11. This table will contain a few rows by default, you need to update them to align the values to your site’s 
implementation and to add additional rows for any additional fields you want to fetch from Dynamics. Populate the 
table cells according to the following table. 

COLUMN NAME DESCRIPTION 

entity The name of the Dynamics entity containing the field to be updated. By default, 
there are three entities which will be mapped.  

 ocpq_oracle_quotes – this is the Oracle Quote entity that is provided 
with the solution. Each oracle quote field that will be fetched and saved to 
the main document will have a row that contains this value in the entity 
column.  

 opportunities – this is the Opportunity entity. Each opportunity field 
that will be fetched and saved to the main document will have a row that 
contains this value in the entity column.  

 opportunityproducts – this is the Opportunity Product entity. Each 
opportunity product field that will be fetched and saved to the sub-
document will have a row that contains this value in the entity column. 

field The schema name of the field on the specified Dynamics entity. A few of the 
default fields will be included, but you must validate these values with your 
environment.  

fieldIsReference Indicates if the mapped field is a Lookup type field on the specified entity. If it is a 
Lookup, it should be set to TRUE. Otherwise it will be set to FALSE.  

document The name of the CPQ document which contains the attribute which is being 
imported from Dynamics. There are two documents which will be mapped.  

 Main document – the main document varname in your CPQ site. In the base 
RefApp it will typically be transaction. Each attribute that will be 
imported from the opportunity or quote in Dynamics will have a row that 
contains this value in the document column.  

 Sub-document – the sub-document varname in your CPQ site. In the base 
RefApp it will typically be transactionLine. Each attribute that will be 
imported from the opportunity product in Dynamics will have a row that 
contains this value in the document column.  

attribute The varname of the attribute on the specified document in CPQ. A few default 
attributes will be included, but you must validate these values with your site.  

process The varname of the process that contains the attributes being mapped. In the 
base RefApp it will typically be oraclecpqo. 
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COLUMN NAME DESCRIPTION 

dataType Specifies the data type of the entity field being retrieved in Dynamics. Supported 
values are: 

 (blank) – Text field and Multiple Lines of Text 

 float - Floating Point Number and Decimal Number 

 currency - Currency 

 date – Date and Time 

 datetime – Date and Time 

 integer - Whole Number 

 menusingle - Option Set 

 menumulti - Multi-Select Option Set 

 boolean - Two Options 

Note: When integrating multi-select menus the variable name of the entry in 
CPQ needs to match the entry in Dynamics.  

Note:  In most cases you must map the Opportunity ID and the Opportunity Product IDs for Import to ensure that 
duplicates are not created when a subsequent Export integration is run. These mappings are usually included by default.  

12. Save and Deploy. 

13. Next, you will update the Account Mappings to map which fields from Dynamics are to be fetched and assigned to 
the Account attributes in CPQ as part of the Autofill and Select Alternate Address actions. Double click on the 
AccountMappings table. 

14. This table will contain a few rows by default, you need to update them to align the values to your site’s 
implementation and to add additional rows for any additional fields you want to fetch from Dynamics. Populate the 
table cells according to the following table. 

COLUMN NAME DESCRIPTION 

integration This specifies which of the integrations will use the mapping. There are two 
actions supported and each has an associated integration.  

 Autofill – this value is the parameter specified in the Account Integration 
BML associated to the Account Autofill action. This BML is defined in the 
Create Account BML Integrations section of this document. 

 Select Alternate Address – this value will be the parameter specified 
in the Address Integration BML associated to the Select Alternate Address 
action. This BML is defined in the Create Account BML Integrations section 
of this document.   

source The schema name of the field on the Dynamics Account or Contact. A few of 
Several the default fields will be included, but you must validate these values with 
your environment.  

destination The varname of the attribute on the CPQ Account or Address object. Several 
default fields will be included, but you must validate these values with your 
environment. 

Note:  The destination attributes in the above table reflect the Account and Address fields on the Accounts object in CPQ, 
they do not represent the associated Quote fields. You must map the Account fields to the Quote fields using the 
Mapping tab on the Autofill and Select Alternate Address actions. 

15. Save and Deploy. 
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SET THE OPPORTUNITY ID ATTRIBUTE 

When punching into CPQ from an Opportunity the Opportunity ID is passed into the quote. Administrators must set which 
Main Document attribute that this ID will be saved to, this is done by setting Opportunity ID to mSDYNOpportunityId_t 
attribute on the Main Document definition. 

Complete the following steps to set the Opportunity ID attribute: 

1. Log in to Oracle CPQ as an administrator. 

2. Under Commerce and Documents, click Process Definition. The Processes page opens. 

3. Locate the name of your Commerce process. 

4. From the associated Navigation menu, select Documents. Click List. The Document List page opens. 

5. From the Document Name column, click on the main document link. In the base Ref App this is typically labeled 
Transaction.  

6. Locate the field Opportunity ID Mapping and set the value to <main document varname>.<opportunity ID 
attribute varname>. If you are using the fields that were included in the Dynamics Integration migration package 
and was installed into a base Ref App this value will be transaction.mSDYNOpportunityId_t. 

7. Click Apply. 

CREATE COMMERCE BML INTEGRATIONS 

The Dynamics Integration migration package includes a set of Commerce Actions, Attribute and Commerce Library, and BML 
Library Functions. However, administrators must manually define a set of BML Integrations which will link these elements 
together and execute the data imports and exports when the specified actions are triggered.  

To create the Import Quote Data Integration, follow these steps: 

1. Open the Admin Home page. 

2. Select Process Definition under Commerce and Documents. The Processes page opens. 

3. From the Navigation menu next to the target process, select Integrations. Click List. The Integrations page opens. 

4. Click Add. The Select Integration Types page opens. 

5. Select the BML option. 

 

6. Click Next. The Edit Integration page opens. 
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7. In the Name field enter a name for the BML integration, in this case Import Quote Data.  

8. The Variable Name field auto-populates upon clicking in or tabbing to the field.  

9. (Optional) In the Description field, provide a description of the integration. 

10. For Integration Type select Requires Partner Session.  

11. Click Define. The Select Attributes page opens. 

12. Under the Library Functions tab select mSDYNImportDataForQuote. 

13. Click Next. The BML Editor opens. 

 

14. Enter the following BML, replacing the commerceProcessName with the varname of your process.  

return commerce.mSDYNExportDataForQuote( 

    "commerceProcessName", 

"ImportMappings", 

    ); 

15. Click Save and Close.  

To create the Export Quote Data Integration, perform the following steps: 

1. Open the Admin Home page. 

2. Select Process Definition under Commerce and Documents. The Processes page opens. 

3. From the Navigation menu next to the target process, select Integrations. Click List. The Integrations page opens. 

4. Click Add. The Select Integration Types page opens. 
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5. Select the BML option. 

 

6. Click Next. The Edit Integration page opens. 

 

7. In the Name field enter a name for the BML integration, in this case Export Quote Data.  

8. The Variable Name field auto-populates upon clicking in or tabbing to the field.  

9. (Optional) In the Description field, provide a description of the integration. 

10. For Integration Type select Requires Partner Session.  

11. Click Define. The Select Attributes page opens. 

12. Under the Library Functions tab select mSDYNExportDataForQuote and mSDYNCollectQuoteFields 

13. Click Next. The BML Editor opens. 
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14. Enter the following BML, replacing the commerceProcessName with the varname of your process.  

return commerce.mSDYNExportDataForQuote( 

    "commerceProcessName", 

"ExportMappings", 

commerce.mSDYNCollectQuoteFields() 

); 

15. Click Save and Close.  

To create the Export Quote Line Data Integration, follow these steps: 

1. Open the Admin Home page. 

2. Select Process Definition under Commerce and Documents. The Processes page opens. 

3. From the Navigation menu next to the target process, select Integrations. Click List. The Integrations page opens. 

4. Click Add. The Select Integration Types page opens. 

5. Select the BML option. 

 

6. Click Next. The Edit Integration page opens. 

 

7. In the Name field enter a name for the BML integration, in this case Export Quote Line Data.  

8. The Variable Name field auto-populates upon clicking in or tabbing to the field.  

9. (Optional) In the Description field, provide a description of the integration. 

10. For Integration Type select Requires Partner Session.  

11. Click Define. The Select Attributes page opens. 

12. Under the Library Functions tab select mSDYNExportDataForLines and mSDYNCollectLineFields 
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13. Click Next. The BML Editor opens. 

 

14. Enter the following BML, replacing the commerceProcessName with the varname of your process.  

return commerce.mSDYNExportDataForLines( 

       "commerceProcessName", 

"ExportMappings", 

commerce.mSDYNCollectLineFields() 

); 

15. Click Save and Close. 

To create the Upsert Primary Quote Info Integration, follow these steps: 

1. Open the Admin Home page. 

2. Select Process Definition under Commerce and Documents. The Processes page opens. 

3. From the Navigation menu next to the target process, select Integrations. Click List. The Integrations page opens. 

4. Click Add. The Select Integration Types page opens. 

5. Select the BML option 
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6. Click Next. The Edit Integration page opens. 

 

7. In the Name field enter a name for the BML integration, in this case Upsert Primary Quote Info.  

8. The Variable Name field auto-populates upon clicking in or tabbing to the field.  

9. (Optional) In the Description field, provide a description of the integration. 

10. For Integration Type select Requires Partner Session.  

11. Click Define. The Select Attributes page opens. 

12. Under the Library Functions tab select mSDYNUpsertPrimaryFlag. 

13. Click Next. The BML Editor opens. 

 

14. Enter the following BML, replacing the commerceProcessName with the varname of your process.  

return commerce.mSDYNUpsertPrimaryFlag("commerceProcessName"); 

15. Click Save and Close. 
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MODIFY THE COLLECT QUOTE FIELDS COMMERCE LIBRARY FUNCTION 

One of the Commerce Library functions that is provided as part of the Dynamics Integration migration package is called 
Collect Quote Fields. The function uses the Export Mappings data table to construct payload for the outbound web service call 
to Dynamics. In order for this function to successfully build the payload the function must take the Commerce Attributes 
which have been mapped as inputs.  

Follow the steps below to modify the Collect Quote Fields Commerce Library Function to support the Export Quote Data 
integration: 

1. Open the Admin Home page. 

2. Select Process Definition under Commerce and Documents. The Processes page opens. 

3. From the Navigation menu next to the target process, select Documents. Click List. The Document List page opens. 

4. From the Navigation menu next to the main document, select Library Functions. Click List. The Commerce BML 
Library Functions List page opens. 

5. Click on the Collect Quote Fields function. The BML Editor opens.  

6. Click Add Attributes and select the attributes which have been populated in the Export Mappings Data Table in the 
previous section.  

7. Modify the BML function to add those new fields to the JSON using the syntax shown.  

 

8. Click Update. 
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MODIFY THE COLLECT LINE FIELDS COMMERCE LIBRARY FUNCTION 

Another of the Commerce Library functions that is provided as part of the Dynamics Integration migration package is called 
Collect Line Fields. The function uses the Export Mappings data table to construct payload for the outbound web service call 
to Dynamics. In order for this function to successfully build the payload the function must take the Commerce Attributes 
which have been mapped as inputs.  

Follow the steps below to modify the Collect Line Fields Commerce Library Function to support the Export Quote Line Data 
integration: 

1. Open the Admin Home page. 

2. Select Process Definition under Commerce and Documents. The Processes page opens. 

3. From the Navigation menu next to the target process, select Documents. Click List. The Document List page opens. 

4. From the Navigation menu next to the main document, select Library Functions. Click List. The Commerce BML 
Library Functions List page opens. 

5. Click on the Collect Line Fields function. The BML Editor opens.  

6. Click Add Attributes and select the attributes which have been populated in the Export Mappings Data Table in the 
previous section.  

7. Modify the BML function to add those new fields to the JSON using the syntax shown.  

 

8. Click Update. 
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CREATE ACCOUNT BML INTEGRATIONS 

Similar to the Commerce BML Integrations, if you wish to use the Account integration features administrators must manually 
define a pair of Account BML Integrations which will execute the data imports when the specified actions are triggered.  

To create the Account Import Integration, follow these steps: 

1. Open the Admin Home page. 

2. Select Accounts under Integration Platform. The Accounts page opens. 

3. Click Integration. The Integrations for CRM page opens.  

4. Click Add. The Edit Integration page opens. 

 

5. In the Name field enter a name for the BML integration, in this case Account Import.  

6. The Variable Name field auto-populates upon clicking in or tabbing to the field.  

7. (Optional) In the Description field, provide a description of the integration. 

8. Click Add. The page will refresh.  

9. Click Define. The Select Attributes page opens. 

10. Under the System Variable Name tab select _system_account_id_field 

11. Under the Library Functions tab select mSDYNImportAsJson_util and getMSDYNCalloutSettingsDict_util 

12. Click Next. The BML Editor opens. 
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13. Enter the following BML. 

// MSDYN Account Import (msdyn_import_account) 
// used in the autofill actions 
//--------------------------------------- 
// PARAMETERS: 
//   * _system_account_id_field : String : dynamics partner entity account id 
// RETURNS 
//   a JSON string that sets CPQ account fields 
// UTILS NEEDED: 
//   _orcl_dyn365.getMSDYNCalloutSettingsDict_util 
//   _orcl_dyn365.mSDYNImportAsJson_util 
//--------------------------------------- 
  
// retrieve base url from the callout settings dictionary 
settingsDict = util._orcl_dyn365.getMSDYNCalloutSettingsDict_util( 
  "dynamicsURL,parentEntity", 
  "account" 
); 
// @TODO add an "_" before customer_id to make this work in normal context 
calloutUrl = get(settingsDict,"dynamicsURL") + "/" + get(settingsDict,"parentEntity") + 
"(" + _system_account_id_field + ")"; 
  
// use a util to make the call, manually add in the partner id field and return the 
result 
result = util._orcl_dyn365.mSDYNImportAsJson_util(calloutUrl, "AccountMappings", 
"Autofill"); 
jsonput(result, "customer_id", _system_account_id_field); 
return jsontostr(result); 

14. Click Save and Close.  

Note:  When calling the orcl_dyn365.mSDYNImportAsJson_util in the above function the third parameter will indicate 
which set of mappings from the AccountMappings table will be used. This must exactly match the value in the 
integration column of that table. See the Configure Callout Settings and Field Mappings section of this guide. 

To create the Address Import Integration, follow these steps: 

1. Open the Admin Home page. 

2. Select Accounts under Integration Platform. The Accounts page opens. 

3. Click Integration. The Integrations for CRM page opens.  

4. Click Add. The Edit Integration page opens. 

 

5. In the Name field enter a name for the BML integration, in this case Address Import.  

6. The Variable Name field auto-populates upon clicking in or tabbing to the field.  

7. (Optional) In the Description field, provide a description of the integration. 
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8. Click Add. The page will refresh.  

9. Click Define. The Select Attributes page opens. 

10. Under the System Variable Name tab select _system_account_id_field 

11. Under the Library Functions tab select mSDYNImportAsJson_util and getMSDYNCalloutSettingsDict_util 

12. Click Next. The BML Editor opens. 

 

13. Enter the following BML.  

// MSDYN Address Import (msdyn_import_address) 
// used in the select contact / select address action 
//--------------------------------------- 
// PARAMETERS: 
//   * _system_account_id_field : String : dynamics partner entity account id 
// RETURNS 
//   a JSON array string that sets CPQ address fields 
// UTILS NEEDED: 
//   _orcl_dyn365.getMSDYNCalloutSettingsDict_util 
//   _orcl_dyn365.mSDYNImportAsJson_util 
//--------------------------------------- 
  
// retrieve base url from the callout settings dictionary 
settingsDict = util._orcl_dyn365.getMSDYNCalloutSettingsDict_util( 
  "dynamicsURL,childEntity", 
  "account" 
); 
// @TODO add an "_" before customer_id to make this work in normal context 
calloutUrl = get(settingsDict,"dynamicsURL") + "/" + get(settingsDict,"childEntity") + 
"?$filter=_accountid_value%20eq%20" + _system_account_id_field; 
  
// use a util to make the call 
// the address list will be a key in the response 
rawResult = util._orcl_dyn365.mSDYNImportAsJson_util(calloutUrl, "AccountMappings", 
"Select Alternate Address"); 
resultArr = jsonget(rawResult, "array", "jsonarray"); 
  
// add a customer id to each element in the response 
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// to stop it from being cleared by the select address autofill 
// (this can also be avoided by setting it to "leave unchanged" on the _customer_id 
attribute 
// but setting it here provides extra security and room for other fixed mappings) 
resultSize = jsonarraysize(resultArr); 
if (resultSize > 0){ 
  loopers = range(resultSize); 
  for looper in loopers { 
    thisElement = jsonarrayget(resultArr, looper, "json"); 
    jsonput(thisElement, "id", _system_account_id_field); 
  } 
} 
  
return jsonarraytostr(resultArr); 
 

Note:  When calling the orcl_dyn365.mSDYNImportAsJson_util in the above function the third parameter will indicate 
which set of mappings from the AccountMappings table will be used. This must exactly match the value in the 
integration column of that table. See the Configure Callout Settings and Field Mappings section of this guide. 

14. Click Save and Close. 

SETUP THE NEW, OPEN, AND SAVE QUOTE ACTIONS  

The Dynamics Integration migration package includes a few Commerce Actions which are added alongside the standard 
actions that are part of the Base Ref App. In order to trigger the Integrations which you defined in the previous section they 
need to be added to these actions.    

 To ensure that the Import Quote Data Integration runs when a new quote is created, complete the following steps: 

1. Open the Admin Home page. 

2. Under Commerce and Documents, select Process Definition. The Processes page opens.   

 

3. Click the name of the target process.  The Process Administration page opens. 

4. Select the Integration tab. 

 

5. Move the Import Quote Data integration from the Available Imports column to the Selected Imports column. 

6. Click Update.  

To ensure that the Import Quote Data Integration runs whenever a quote is opened, complete the following steps: 

1. Open the Admin Home page. 
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2. Select Process Definition under Commerce and Documents. The Processes page opens. 

3. From the Navigation menu next to the target process, select Process Actions. Click List. The Process Action List 
page opens. 

4. Click on the Open Transaction Action. The _open_transaction page detail opens.  

 

5. Select the Integration tab. 

6. Move the Import Quote Data integration from the Available Imports column to the Selected Imports column. 
Ensure that the integration is listed below the Apply Modify Functions row so that it runs afterwards.  

 

7. Click Apply.  

To ensure that the Export Quote Data, Export Line Data, and Upsert Primary Quote Info Integrations all run whenever a quote 
is Saved and Synced, complete the following steps: 

1. Open the Admin Home page. 

2. Select Process Definition under Commerce and Documents. The Processes page opens. 

3. From the Navigation menu next to the target process, select Documents. Click List. The Document List page opens. 

4. From the Navigation menu next to the main document, select Actions. Click List. The Actions List page opens. 

5. Click on the label for the msDynamicsSave action. The msDynamicsSave detail page opens.  

 

6. Select the Integration tab. 

7. Move the Export Quote Data, Upsert Primary Quote Info and Export Line Data integrations from the Available 
Imports column to the Selected Imports column. Ensure that the integrations are listed below the Apply Modify 
Functions row so that it runs afterwards.  
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8. Click Apply. 

Notes:    

 Any action that needs to synchronize data with Dynamics 365 must have the proper integration action created. 

 Administrators cannot remove Apply Modify Functions from the Selected Integration list. They must order all 
BML integrations around Apply Modify Functions.  

 Multiple actions can reference the same BML integration.  

 When a BML integration references a process action, administrators cannot delete it.   

 Non-BML integrations are not allowed when a BML integration is applied to a process action. Similarly, BML 
integrations are not allowed when a non-BML integration is applied to a process action. An error message will 
display stating that BML type integrations cannot be mixed with other integration types. 

SETUP THE AUTOFILL AND SELECT ALTERNATE ADDRESS ACTIONS  

The integration supports the automatic import of Account information using the Autofill action and the selection of alternate 
contact and address info using the Select Alternate Address action. In order to trigger the Integrations that you defined in the 
earlier section they need to be added to these actions and the mappings on those actions must be defined. 

To add the Account integration to the Autofill process action, perform the following steps: 

1. Open the Admin Home page. 

2. Select Process Definition under Commerce and Documents. The Processes page opens. 

3. Identify the target process to which the BML type Account integration applies. 

4. From the associated Navigation menu, select Documents. 

5. Click List. The Document List page opens. 

6. Select Actions from the Navigation menu at the Transaction level. 

7. Click List. The Action List page opens. 

8. Select the Autofill/Refresh Address action. The _auto_fill_action detail page opens. 

9. Select the Modify tab. 

10. Set all the attributes you want to auto-populate in the Oracle Quote to Leave Value Unchanged. 

11. Select the Mappings tab. All of the attributes available in the Oracle CPQ Account object display. 
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12. Map the attributes to Transaction attributes. The Autofill action retrieves the mapped account values and saves them 
to the Oracle Quote.  

 

13. Select the Integration tab. 

14. From the CRM Mapping menu, select the Account Import Integration.  

 

15. Click Apply. 

To add the Address Integration to the Select Alternate Address action, perform the following steps: 

1. Open the Admin Home page. 

2. Select Process Definition under Commerce and Documents. The Processes page opens. 

3. Identify the target process to which the BML type Account integration applies. 

4. From the associated Navigation menu, select Documents. 

5. Click List. The Document List page opens. 

6. Select Actions from the Navigation menu located at the Transaction level. 

7. Click List. The Action List page opens. 

8. Select the Select An Alternate Address action (i.e. _select_alternate_address_action). The 
_select_alternate_address_action detail page opens. 

9. Select the Modify tab. 



 

 

Oracle CPQ Connector for Microsoft Dynamics 365 Installation and Setup Guide 57 

 

10. Set all the attributes to auto-populate in the Oracle Quote to Save From Form. 

11. Select the Mappings tab. All of the attributes available in the Oracle CPQ Address object display. 

12. Map the Account Address attributes you want to display in the Oracle Quote to Transaction attributes.   

 

13. Select the Integration tab. 

14. From the CRM Mapping menu, select the name of your BML type Account integration.  

 

15. Click Apply. 
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SYNCHRONIZE QUOTE LINES TO OPPORTUNITY PRODUCTS 

When a sales rep is ready to activate a Quote, thereby pushing the product and pricing information to the Opportunity for 
forecasting, they can check a box on the Quote and initiate a Save and Sync. The Dynamics Integration migration package 
includes an attribute which functions in conjunction with the actions and integrations previously defined called the Quote is 
Primary attribute. This attribute is a Boolean attribute type which can be checked and unchecked to toggle the Opportunity 
Product syncing behavior.  

When users click the Quote is Primary checkbox on a Quote marked as the "primary" or "active" Quote on the Opportunity, 
the line items on the primary Quote are synced to the Opportunity as Opportunity products. If you have synchronized your 
price books, these Opportunity Products will be synced as Price List Items. 

Notes:   

 Before line items can be synced as Price List items, administrators must complete the procedures in Parts Sync.  

 Once the Price List has been assigned to the Opportunity and products have been added the price list cannot be 
changed.  

To set up the Quote is Primary attribute on the Main Document follow these steps.  

1. Open the Admin Home page. 

2. Select Process Definition under Commerce and Documents. The Processes page opens. 

3. From the Navigation menu next to the target process, select Documents. Click List. The Document List page opens. 

4. From the Navigation menu next to the main document, select JET Responsive Layout. Click List. The Actions List 
JET Layout Editor page opens. 

5. Open the Add menu and select Attributes. The Attributes pane displays.  

6. In the Filter type Quote is Primary. The attribute will display in the results.  

7. Drag the Quote is Primary attribute onto the page layout in a prominent location.  

8. Click Save.  

9. Deploy the process. 
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PARTS SYNC 
In order to create Opportunity Products as part of your Opportunity and Quote synchronization, those products must exist in 
both Dynamics and Oracle CPQ. This also establishes a master product list that prevents duplicate product data and ensures 
consistent pricing.  

This section provides instructions for the following activities: 

 Verify the Parts Master 

 Synchronizing Price Books and Parts 

 Specifying the Unit of Measure 

Note:  The automated Parts Integration features are not supported with Microsoft Dynamics 365. Any attempts to 
import or export parts using this capability will result in errors.  

Verify the Parts Master 
Determining the system to be your Parts Master is a choice that administrators must make when designing the initial setup of 
the system. By default, the Base Reference Application, as provisioned with new Oracle CPQ sites, assigns Oracle CPQ as the 
Parts Master. However, this assignment is not used explicitly in the Dynamics parts setup. Your specific business process 
should drive the decision of the Parts Master selection. Generally, we recommend using CPQ as your Parts Master, but you can 
choose Dynamics as your parts master or another master data management solution. Regardless of your choice, you must 
ensure that both Dynamics and CPQ have a synchronized representation of your parts list.  

Note:  In order to change your Parts Master assignment, you must log an SR in My Oracle Support. Refer to Log an 
Oracle CPQ Connector for Microsoft Dynamics 365 Service Request . When using the Dynamics integration changing this 
will have no effect on the system behavior.  

To check your current Parts Master selection, complete the following steps: 

1. Log in as SuperUser. 

Note:  To view the Parts Integration Settings page, you must be logged in as SuperUser 

2. Navigate to Admin Home page. 

3. Click Parts. The Parts Administration page displays. 

4. Under the Item Master section, the selected Parts Master displays. The two available options are:  

• BigMachines - indicates Oracle CPQ as the Parts Master  

• Partner - indicates Dynamics or other as the Parts Master. 

Synchronizing Price Books and Parts 
Once you’ve selected your Parts Master and you have created your products and price books in that system, you’re ready to 
synchronize your products/parts and price lists/books between systems. Until you have completed this step, you are not able 
to successfully synchronize quotes with opportunities.  

Note:  The steps outlined below will cover the basic process for manually mapping and updating the data across systems, 
however the ultimate process that your business settles on should be governed by the requirements laid out by the 
business stakeholders. In most situations an automated process is preferred, sometimes using web services, bulk data 
services with SFTP or middleware, and the configuration of such a custom flow is outside the scope of this document. 
You should contact your System Integrator if you have questions around this process. 
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PRICE BOOK MAPPING 

Unless you are using Write-In products, all products in Dynamics are typically contained in at least one Price List. Often 
customers use multiple Price Books to organize their products and segment their pricing. Before you can sync parts, you must 
manually map each Price List ID from Dynamics to the corresponding Price Book in CPQ. 

Note:  If you were not previously using Price Lists in either Dynamics or CPQ, you may need to create those records in 
each system before they can be mapped. Refer to the online help for each application for more details. 

To retrieve the Price List ID from Dynamics, perform the following steps: 

1. Log in to Dynamics 365 as an administrator. 

2. Open the Sales menu from the top navigation bar. 

3. Click Settings. 

4. Click the Product Catalog link. 

 

5. Click the Price Lists link. 

 

6. From the Active Price Lists page, click Export to Excel. 

7. Open the downloaded Excel file. If necessary, click Enable Editing.  
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8. You may also need to unhide the column containing the price list ID. This can be done by selecting all columns by 
clicking the triangle in the upper left corner. 

 

9. Right-click the first column header and select Unhide. 

 

10. Verify that column A contains an ID. 

 

11. Record this value. 

Next, you need to map the exported Price List ID to the associated Price Book in Oracle CPQ. To do so, perform the following 
steps: 

1. Log into Oracle CPQ as a FullAccess user.  

2. Open the Admin Home page. 

3. Under Products, select Parts. The Part Administration page opens. 

4. Click List in the Price Book area of the page. The Price Book Administration List page opens. 

5. Select the name of the Price Book to update. The Price Book Administration page opens. 

6. Paste the paired Price List ID into the Partner Price Book Id field. 

7. Click Update. 

8. Repeat the above steps for each paired Price List. 
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EXPORT PARTS AND PRICE BOOK ASSOCIATIONS FROM ORACLE CPQ 

Once you have completed the previous steps, you are ready to export part data from Oracle CPQ.   

To export parts from Oracle CPQ, perform the following steps. 

1. Open the Admin Home page. 

2. Navigate to Utilities > Bulk Data Services > Download. The Download Category List page opens. 

3. Select the Parts radio button. 

4. Click Next. The Search Criteria page opens. 

5. Select CSV as the Download Format. 

6. Enter search criteria to filter the resulting export as desired. 

7. Click Download. 

8. When the download completes, click the Module link on the Download Status page to download the results. 

9. Optionally, if you are using Price Book Associations you will repeat these steps to export them as well.  

IMPORT PRODUCTS INTO DYNAMICS 

Once the parts have been retrieved from CPQ, you can prepare the upload file and import them into Dynamics.  

To import Oracle CPQ parts to Dynamics 365, perform the following steps: 

1. Log in to Dynamics 365. 

2. Under the Sales menu in the top navigation bar, select Settings. 

3. Select Data Management. The Data Management page opens. 

4. Select Templates for Data Import.  

5. From the menu select Product. Click Download.  

6. Retrieve the Parts CSV from Export Parts and Price Book Associations from Oracle CPQ.  

7. Using the template you just downloaded, prepare your upload file using the CSV editor of your choice. Copy the parts 
exported in the prior section into the file and populate the associated columns to their Dynamics counterpart. Ensure 
all required fields are populated.  

8. Next, Select Imports. The My Imports page opens. 

9. Click IMPORT DATA. The Upload Data File dialog opens. 

10. Select the file containing the parts. 

11. Click Next. 

12. Review the mapping dialog.  

13. Click OK. 
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14. Click to allow or disallow duplicates and assign an owner for the import. 

 

15. Click Submit. 

16. Click Finish. 

ACTIVATE DYNAMICS 365 PRODUCTS 

The products in the Dynamics 365 site must be active before they can be added to an Opportunity. If they were imported in 
the prior step with the Status set to “Draft” and thus are inactive, administrators can bulk activate the products. For additional 
information, refer to the Microsoft Dynamics 365 documentation. 

To activate Dynamics 365 products, perform the following steps: 

1. Log in to Dynamics 365. 

2. Open the Sales menu from the top navigation bar. 

3. Select Settings. 

4. Select the Product Catalog link. 

5. Select Families & Products. 

 

6. From the All Products, Families & Bundles page, select EXPORT TO EXCEL. 

https://docs.microsoft.com/en-us/dynamics365/customer-engagement/developer/publish-revise-revert-retire-activate-products
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7. Save the file. 

8. Open the downloaded spreadsheet. 

9. Set the Status column to “Active” for all products you want to activate. 

10. Save the spreadsheet. 

11. Under the Sales menu in the top navigation bar, select Settings. 

12. Select Data Management. The Data Management page opens. 

13. Select Imports. The My Imports page opens. 

14. Click IMPORT DATA. 

15. Follow the import wizard’s steps. The products are now activated. 

IMPORTING PRICE LIST ENTRIES 

Now that you have uploaded products to Dynamics, you can now add them to Price Lists and assign them prices.   

To import Oracle CPQ price book associations to Dynamics 365, perform the following steps: 

1. Log in to Dynamics 365. 

2. Under the Sales menu in the top navigation bar, select Settings. 

3. Select Data Management. The Data Management page opens. 

4. Select Templates for Data Import.  

5. From the menu select Price List Items. Click Download.  

6. Retrieve the Price Book Associations CSV from Export Parts and Price Book Associations from Oracle CPQ .  

7. Using the template you just downloaded, prepare your upload file using the CSV editor of your choice. Copy the price 
book associations exported in the previous section into the file and populate the associated columns to their 
Dynamics counterpart. You will also need to supply the Price List name and Product name created in previous steps 
into this file. Ensure all required fields are populated.  

8. Next, Select Imports. The My Imports page opens. 

9. Click IMPORT DATA. The Upload Data File dialog opens. 

10. Select the file containing the price book associations. 

11. Click Next. 

12. Review the mapping dialog. 

13. Click OK. 
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14. Click to allow or disallow duplicates and assign an owner for the import. 

 

15. Click Submit. 

16. Click Finish. 

17. Repeat these steps for each remaining price list.  

UPDATE PARTS IN ORACLE CPQ 

Once you’ve created the product and price list data in Dynamics, you need to associate these new records with the originating 
parts and price book data in CPQ.  

First you need to retrieve the Price List Entry IDs that were created in the previous step. Follow these steps: 

1. Log in to Dynamics 365. 

2. Under the Sales menu in the top navigation bar, select Settings. 

3. Navigate to the Product Catalog area.   

4. Click on Families and Products.  

5. Click on Export to Excel to download the products.  

6. Open the downloaded file. Unhide all columns.  

7. Retrieve the Parts CSV from Export Parts and Price Book Associations from Oracle CPQ.  

8. Copy the Product IDs from the exported Products file into partner_part_id column in the Parts CSV, taking care that 
the rows in each file are correctly mapped using your preferred CSV editor.  

9. Set the Update column to “Update” for all parts. 

10. Save the CSV. 

11. Return to the Product Catalog area.   

12. Click on Price Lists.  

13. Select the Price List that you updated in the previous step.  
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14. Under Price List Items click on the grid icon to display all items associated with this price list.  

15. Click on Export Price List Items to download the items.  

16. Open the downloaded file. Unhide all columns.  

17. Retrieve the Price Book Associations CSV from Export Parts and Price Book Associations from Oracle CPQ.  

18. Copy the Price List IDs from the exported Price List file into partner_price_book_entry_id column in the Parts CSV, 
taking care that the rows in each file are correctly mapped using your preferred CSV editor.  

19. Set the Update column to “Update” for all parts. 

20. Save the CSV.  

21. Log into Oracle CPQ as a FullAccess user.  

22. Navigate to Utilities > Bulk Data Services > Upload. The Upload Files List page opens. 

23. Click Choose File from the Add Files For Upload section.  

24. Select the Parts CSV from the previous steps. 

25. Click Add.  

26. Select uploaded file and click Upload.   

27. When the upload completes, click the Log link to view the results. 

28. Repeat the previous 5 steps for the Price Book Associations CSV file.  

29. It is recommended that you spot check a few parts to validate that the partner_part_id and the 
partner_price_book_entry_id were applied correctly.  

IMPORT PARTS AND PRICE BOOK ASSOCIATIONS TO ORACLE CPQ 

If your business process requires you to inverse the previous process, mastering your products and pricing in Microsoft 
Dynamics and exporting the data to Oracle CPQ you can follow the below steps. This process is not documented in granular 
detail because many of the steps are identical to those in the previous sections. These steps will outline the high-level order of 
operations.  

To export products and prices from Dynamics and import them into CPQ, follow the below steps.  

1. Log into Dynamics and navigate to the Product Catalog.  

2. Export the Price Lists and unhide the Price List IDs. 

3. Export the Price List Entries and unhide the Price List Entry IDs. 

4. Export the Products and unhide the Product IDs.  

5. Log into Oracle CPQ and navigate to the Downloads section of Bulk Data Services.  

6. Download the Parts and Price Book Associations files to use as an upload template.  

7. Create the Price Books in CPQ that will be associated with the existing Dynamics Price Lists.  

8. Populate the partner_price_book_id following the steps described in Price Book Mapping.  

9. Copy the Product data from the from the exported Products file into the Parts upload template.  

10. Upload the Parts into CPQ and validate that the partner_part_id and other part fields are correctly populated.  

11. Copy the Price List Entry data from the exported Price List Entry file into the Price Book Associations upload 
template. Ensure that the previously created price book varnames are populated in the price_book_variable_name 
column.  

12. Upload the Price Book Associations and validate that the partner_price_book_entry_id and other prices are correctly 
populated.  
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Specify Unit of Measure 
To create Opportunity line items linked to Dynamics products, administrators must specify a unit of measure for the 
opportunity items.  

In the supplied Dynamics Integration migration package, the “commerce.mSDYNExportDataForLines()” library function 
hard codes the unit of measure ID under the variable unit of measure.  Administrators will need to update the “uomid” in the 
“commerce.mSDYNExportDataForLines()” library function to match the unit of measure ID in their organization. See the 
code snippet below for reference.   

 

Note:  If your organization uses multiple units of measure you will need to assign the units of measure dynamically in 
CPQ. This can be accomplished using CPQ’s units of measure, custom part attributes, formula management or BML 
libraries but that implementation is outside the scope of this document. You should contact your System Integrator if you 
have questions around this process.    

To locate the Unit of Measure ID in Dynamics, perform the following steps: 

1. Log into Microsoft Dynamics as an administrator.  

2. Using a browser or an API client, view the Units of Measure endpoint. This endpoint takes the format of: 
[organization URI]/api/data/v9.0/uoms 
For example:  

 

3. Within the results, locate “uomid” field. 

 

4. Record this value.  

5. Next, you must update the commerce.mSDYNExportDataForLines()function on your Commerce Process. To do so, 
perform the following steps.  

6. Log into Oracle CPQ as a FullAccess user.  

7. Go to the Admin Home page.  



 

 

Oracle CPQ Connector for Microsoft Dynamics 365 Installation and Setup Guide 68 

 

8. Click on Process Definition. The Processes page displays,  

9. Locate your Process and choose Documents from the navigation menu and click List. The Documents List displays.  

10. Locate your main document, typically labeled Transaction, and choose Library Functions from the navigation menu 
and click List. The Commerce BML Library Functions List displays.  

11. Locate the Export Data For Lines function from the list and click the link. The BML editor opens.  

12. Locate the line in the function that sets the value for the uomid and update it to set it to the uom ID value retrieved 
above.  

13. Click Update. 

14. Deploy the Process. 
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USER PAIRING 
Integrated users will have two user accounts—one in Dynamics and one in Oracle CPQ. Once users are provisioned and 
paired, users are able to Single Sign On (SSO) from Dynamics to Oracle CPQ. 

Manually Integrate Users from Oracle CPQ 
If you have users in Oracle CPQ which need to be paired to Dynamics users, you can manually create the connection. This 
establishes the relationship between the two user accounts and prepares them for SSO.  

These steps are similar to the integration user pairing except with other user types. You can repeat these steps for as many 
users as required. 

Note:  Do not proceed with this process until Oracle CPQ Support has completed the Service Request to establish the 
security and connected app. Refer to Log an Oracle CPQ Connector for Microsoft Dynamics 365 Service Request. 

PAIR USER AND GENERATE TOKEN 

The first step for integrating users is to pair the user accounts across systems. This is done by entering the Dynamics 
username that corresponds to the CPQ user on the User Integration page. In this section, we describe how to manually pair 
users.  

Once users have been paired, a user token can be generated before those users are allowed to SSO from Dynamics into Oracle 
CPQ. If a token is not manually generated, it will automatically be generated when that user punches in from Dynamics for the 
first time. Once a user has generated this token, they will continue to be able to sign on from Dynamics even after their 
Dynamics or CPQ user password changes. This section describes how to manually generate the token. If a user has been 
paired, but a token has not been generated, the user is prompted to do so when they first attempt to login to Oracle CPQ.  

Note:  Before you begin, log out of all Microsoft Dynamics instances so that you do not accidently pair to the wrong user 
account or organization.  

To pair a user and generate a token, complete the following steps: 

1. Log into Oracle CPQ with the Username and Password for the user to be paired. 

 

2. Click the My Profile icon in the Navigation bar at the top of the page. 

 

Note:  The My Profile icon and location may vary based on your CPQ site configuration.  
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3. Click User Integration. 

 

4. Enter the Dynamics Username that you are pairing to in the Login field. 

5. Click Generate Token. 

 

6. Log in to Dynamics with the credentials for the user account you want to integrate. 

 

The User Integration page displays with confirmation that the Token Generated  

 

Note:  If you try to access Oracle CPQ from Dynamics with a user that has not been paired, they will see errors when 
trying to open quotes.  



 

 

Oracle CPQ Connector for Microsoft Dynamics 365 Installation and Setup Guide 71 

 

APPENDIX A: MIGRATION PACKAGE COMPONENTS 
The components included in the Microsoft Dynamics Integration package are identified in the following tables. 

COMMERCE MAIN DOCUMENT ATTRIBUTES 

Attribute Name Variable Name Description 

Opportunity ID mSDYNOpportunityId_t ID of MS Dynamics Opportunity entity record. When a quote 
is created in Dynamics 365, the Oracle CPQ Transaction 
receives the Dynamics 365 “Opportunity ID”. 

Quote ID mSDYNQuoteId_t ID of MS Dynamics Oracle Quote entity record 

Quote Is Primary mSDYNIsPrimaryQuote_t Boolean to indicate the Quote is the primary Quote on the 
Opportunity entity record. This tells the system to create 
Opportunity Line Item records when the systems are 
synchronized. 

Primary Quote ID mSDYNPrimaryQuoteId_t ID of Microsoft Dynamics Oracle Quote entity record that is 
marked as primary on the Opportunity entity record. 

Opportunity Line IDs mSDYNOpportunityLineIds_t List of all line item IDs that exist on the Opportunity in 
Microsoft Dynamics.  

 

COMMERCE SUB-DOCUMENT ATTRIBUTES 

Attribute Name Variable Name Description 

Opportunity ID 

 

mSDYNOpportunityId_l ID of MS Dynamics Opportunity entity record. 

Opportunity Line ID mSDYNOpportunityLineId_l ID of Microsoft Dynamics Opportunity Line entity record. 

 

COMMERCE LIBRARY FUNCTIONS 

Attribute Name Variable Name Description 

Collect Quote Fields mSDYNCollectQuoteFields Function for administrator to update with main document 
attributes mapped in the Import and Export mapping tables 

Collect Line Fields mSDYNCollectLineFields Function for administrator to update with sub document 
attributes mapped in the Import and Export mapping tables 

Import Data For Quote mSDYNImportDataForQuote Imports quote data from Dynamics 

Export Data For Quote mSDYNExportDataForQuote Exports quote main doc data to Dynamics.  
Supports writing to CPQ Quote and Opportunity entities. 

Upsert Primary Flag mSDYNUpsertPrimaryFlag Sets the primary quote id in Dynamics 
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COMMERCE LIBRARY FUNCTIONS 

Export Data For Lines mSDYNExportDataForLines Exports quote main doc data to Dynamics 

 

BML LIBRARY FUNCTIONS 

Attribute Name Variable Name Description 

Convert Batch 
Response To Info Pool 

convertMSDYNBatchResponseToI
nfoPoolUtil_util 

Converts batch responses into a dictionary of string 
dictionaries-Key[Content-Id(string)]:Value[batch response 
for a single job(string dictionary)] 

Get Callout Settings getMSDYNCalloutSettingsDict_util Gathers information to make internal REST callouts [CPQ for 
Doc/SubDoc data], as well as external [MS Dynamics] 

Get Field Mappings getMSDYNFieldMappings_util Gathers mappings of MS Dynamics entity fields to CPQ 
doc/subdoc attributes 

Get Child IDs mSDYNGetChildIDs_util Queries dynamics for all the child object IDs with a given 
parent. During opportunity product synchronization, this is 
used to determine what products to delete. 

Process Response  processMSDYNResponse_util Takes in the response of a call to create or update a singular 
entity record in MS Dynamics and parses out the ID of the 
record(SUCCESS) or an error message(FAILURE)  

Map JSON Attrs By 
Type 

mapJsonAttrsByType_util Takes in a source js object, and maps its values to a target js 
object, while typing and substituting values where 
necessary.  

Process Import Data mSDYNProcessImportData_util Handles mapping of main doc fields, as we only need to 
handle syncing of quote level data on initial import 

 

DATA TABLES 

Table Name Description 

CalloutSettings Holds integration settings 

ImportMappings Holds mapping of Microsoft Dynamics entity fields to OCPQ attributes 

ExportMappings Holds mapping of OCPQ attributes to Microsoft Dynamics entity fields 
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APPENDIX B:  DYNAMICS SOLUTION COMPONENTS 
The components included in the Oracle CPQ Connector for Microsoft Dynamics 365 solution are identified in the following 
tables. 

Packaged Components 

COMPONENT  DESCRIPTION 

Oracle Quote Entity The representation of a CPQ Commerce Transaction, appearing as a 
list on the Opportunity page. This entity is where new quotes are 
created from and shows a list of any previously created quotes. 
Clicking a quote in this list opens that record for editing. 

CPQ Site Settings Entity Allows administrator to supply a number of parameters for retrieval 
by the integrated Oracle CPQ site. 

Opportunity Entity The representation of the Dynamics 365 Opportunity, which stores 
the Oracle Quotes displayed in the Oracle Quote entity. 

CPQ Admin  The Admin security role name. 

CPQ Admin Field Security Profile Gives create, update, and delete rights to the Opportunity, Oracle 
Quote, and CPQ Site Settings. 

CPQ Sales  The Sales security role name. 

CPQ Sales Field Security Profile Gives create, update, and delete rights to the Opportunity and Oracle 
Quote and read access to CPQ Site Settings. 

Web Resources Includes the following: 

 CPQ iFrame Loader: Display name of the javascript supports the 
display of the Oracle Quote page within an iFrame in Dynamics 
365 when users create or edit quotes from Dynamics 365.   

 ocpq_iframe_loader: The API name of the javascript that assists 
with the flow for creating and editing quotes. 

 ocpq_style: The CSS file that styles the Oracle Quote page 
holding the iFrame.  

 ocpq_oq_icon_large: The Oracle Quote icon (32 px)  

 ocpq_oq_icon_small: The Oracle Quote icon (16 px) 

 ocpq_oa_icon_large: The CPQ Site Setting icon (32 px) 

 ocpq_oa_icon_small: The CPQ Site Setting icon (32 px) 
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Oracle Quote Entity 
The following table identifies the fields available in the Oracle Quote entity. 

cpq_oracle_quote 

Field Name Label Description 

ocpq_name Name Holds the name of the Oracle CPQ Transaction. 

ocpq_oracle_quoteid Oracle Quote Holds the unique identifier for entity instances. 

ocpq_opportunity_id Opportunity ID Holds the lookup to the Opportunity record.  

ocpq_cpq_site_setting_id CPQ Site Holds the unique identifier needed to connect 
to the correct Oracle CPQ instance. 

ocpq_bs_id Buyside ID Holds the Buyside ID associated with the 
Oracle CPQ Transaction.  

CPQ Site Settings Fields 
The following table identifies the fields available in the CPQ Site Settings entity. 

cpq__cpq_site_setting 

Field Name Label Description 

ocpq_name Name Holds the display name of the Oracle CPQ site. 

ocpq_process Process Name Holds the varname of the Oracle CPQ Commerce 
process. 

ocpq_process_id Commerce Process ID Holds the ID of the Oracle CPQ Commerce 
process. 

ocpq_action_id_open Open Action ID Holds the ID of the integration action that 
executes upon entering the Oracle Quote page to 
edit a quote. 

ocpq_document_id Document ID Holds the ID of the Oracle CPQ Document. 

ocpq_url Site Domain Holds the URL of the root domain of the Oracle 
CPQ site.  

Include the https:// 

Note: The CPQ site must have SSL enabled 

ocpq_site_settings_id CPQ Site Settings Holds the unique identifier needed to connect to 
the correct Oracle CPQ instance. 
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APPENDIX C:  CUSTOMIZATION AND EXTENSIBILITY 
This section provides information about optional customized integration behaviors that you may want to implement. 

Using URL Data Functions to Access Microsoft Dynamics 365 Web Services 
When integrating Oracle CPQ with a CRM system such as Microsoft Dynamics 365, the integration uses an OAuth access 
token to authenticate user access to the CRM system. Generated automatically when the user accesses Oracle CPQ from the 
CRM system, the token supports the synchronization of data between Oracle CPQ and the CRM system.  

Oracle CPQ Release 17D and later allows administrators to use a BML function to retrieve a user's access token during a 
Microsoft Dynamics 365 integrated session. By inserting an access token into the header of a BML URL data function, Oracle 
CPQ can securely write data to Dynamics 365. 

$_access_token_dynamics365$ - For Microsoft Dynamics 365 integrated sessions 

When using OAuth-based Single Sign-On from Dynamics 365 to access Oracle CPQ, the system replaces the access token 
variables above in an "urlData" function with the user's active access token. This establishes a secure connection between 
Oracle CPQ and Dynamics 365.  

For example:  
The header would appear as follows to request a list of Microsoft Dynamics 365 opportunities: 

headers=dict("string"); 
put(headers, "Authorization", "Bearer $_access_token_dynamics365"); 
response=urldata(https://api/data/v8.2/opportunities , GET, headers); 
print response; //prints out opportunity information 

Note:   

 If the user does not have an integrated session, the access token variable is replaced with a blank. 

 The partner login icon will generate a token for the user as long as the user has generated a token and logged in at 
least once in the past. 

 An invalid or expired access token results in an error from the target system. 

https://api/data/v8.2/opportunities
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TROUBLESHOOTING 
The section provides an up-to-date list of both helpful insights and solutions to known issues regarding the Oracle CPQ 
Connector for Microsoft Dynamics 365. This information is intended for administrators and developers because it provides 
implementation help and solutions to known issues. 

Troubleshooting Issues 
If you are encountering a problem the table below may have a solution to your issue. 

ISSUE POSSIBLE SOLUTION 

 Products are being synced as Write 
In products and not as Price List Items. 

Older versions of the Microsoft Dynamics Integration Package did not 
use Price Lists. If are upgrading and wish to use Price Lists, 
administrators must perform the following steps: 

1. Edit the msDYNUpsertPrimaryFlag.bml commerce library in your 
process. 

2. Add your _partner_price_book_id as quote level input. 
3. Find the pricebook = ""; line in the commerce library. 
4. Change the double quotes to the variable name. 
5. For example: pricebook = _transaction_partner_price_book_id; 
6. Save the changes to the library. 
7. Deploy Commerce. 

 The mSDYNExportDataForQuote 
commerce library function is not 
working properly. 

 

In the mSDYNExportDataForQuote commerce library function, included 
in the Microsoft Dynamics migration package, there is a line where a 
variable's value is assigned to itself: 

if(updateQuote) { 

calloutURL = calloutURL + 

Solution:  Verify the value of the calloutURL is accurate. 

 System not responding when 
opening an opportunity or quote using 
the Unified UI. 

When logged into an Oracle CPQ site using legacy layout and opening 
an opportunity or CPQ quote using the Unified UI, the site does not 
respond. After a few minutes, if the user click on a new quote or to edit 
an existing quote, a script error displays. 

Solution:  Refresh the page or click on the opportunities list to proceed. 
No data is lost due to this issue. 

 When using the Unified UI, an error 
message displays when performing a 
page refresh while creating a new 
quote or editing an existing quote. 

Perform a MS Dynamics Save action and reopen the quote under the 
respective opportunity. No data is lost due to this issue. 

 In the Unified UI, the navigation 
path displays incorrectly in the page 
header. 

When using the Unified UI navigation path in the page header, check to 
ensure you are selecting the appropriate location in the navigation path. 

 When creating a new quote, 
multiple quotes with the same BSID are 
created. 

Multiple quotes with the same BSID may be created if the Opportunity ID 
or Part Partner ID is incorrect when entering a new quote. 

Solution:  Verify the correct Opportunity ID and Part Partner ID are 
entered. 

If you do not see a solution to your issue, you can Log an Oracle CPQ Connector for Microsoft Dynamics 365 Service Request. 
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ADDITIONAL CONSIDERATIONS 
Review the following additional information about your Oracle CPQ integration with Microsoft Dynamics 365.  

Sandbox Testing 
Always install or upgrade the managed solution in a Dynamics sandbox and test the instance of Oracle CPQ before installing 
or upgrading in production. 

Dynamics Integration Support 
Oracle officially supports version 1.0, and 0.3 of the Oracle CPQ Connector for Dynamics.  

Note:  Previous versions of this solution are expected to continue to function; however Oracle will not address new issues 
that arise. We strongly encourage customers to upgrade to the latest supported version.   

Training 
Please refer to the release documentation for all versions between your current version and the version to which you are 
installing to see all new functionality, resolved known issues, and functional known issues.  

Refer to the Oracle CPQ Online Help to become familiar with the new features introduced in Oracle CPQ. For additional help, 
see My Oracle Support. 

Verify any information not explicitly mentioned in this document as supported by the software against the product help for 
Oracle CPQ or the Oracle CPQ Consulting team. 

Additional Information 
 For more information on Oracle CPQ, visit the Oracle CPQ Documentation site. 

 For information about the sales user experience for creating, updating, and deleting Oracle CPQ Quotes from within 
Dynamics 365, refer to the Microsoft Dynamics 365 Integration section of the CPQ Cloud Release 18A What’s New 
Document or the Oracle CPQ Administrator Online Help. 

 For information about Azure Active Directory, refer to the Azure Active Directory Documentation. 

 For information about setting up users and roles in Dynamics 365, refer to the documentation provided on 
https://www.office.com. 

DISCLAIMER 
The details in this document are provided for high-level informational purposes only and are not intended to function as a 
specification or to replace the Online Help. Upgrading to a subsequent release may require the re-deployment of Commerce 
Processes, Configuration, CPQ Site Settings, or global function settings. Modifications to integration XSL files or APIs may also 
be required.  

 

 

https://support.oracle.com/
http://docs.oracle.com/cloud/latest/cpq_gs/index.html
https://support.oracle.com/epmos/faces/DocumentDisplay?_afrLoop=287314224034968&id=1674718.1&_afrWindowMode=0&_adf.ctrl-state=11fvn8rjpp_4
https://support.oracle.com/epmos/faces/DocumentDisplay?_afrLoop=287314224034968&id=1674718.1&_afrWindowMode=0&_adf.ctrl-state=11fvn8rjpp_4
https://docs.microsoft.com/en-us/azure/active-directory/active-directory-whatis
http://office.com/
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